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 © Copyright 2018 Indu-Sol GmbH 

 

We reserve the right to amend this document without notice. We continuously work on further developing 

our products. We reserve the right to make changes to the scope of supply in terms of form, features and 

technology. No claims can be derived from the specifications, illustrations or descriptions in this 

documentation. Any kind of reproduction, subsequent editing or translation of this document, as well as 

excerpts from it, requires the written consent of Indu-Sol GmbH. All rights under copyright law are 

expressly reserved for Indu-Sol GmbH. 

 

Caution! 

This device may only be put into operation and operated by qualified personnel. Qualified personnel, as 

referred to in the safety-related information of this manual, are persons who are authorised to put into 

operation, to earth and to label devices, systems and electrical circuits in accordance with the standards 

of safety engineering. 
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1 General information 

The AS-Interface network diagnosis tool 'ASi View' measures the quality of transmission of AS-Interface 

networks and determines, whether these work error free. It can be used either in the field at the network 

installation or in the development laboratory. 

 

The 'ASi View' supports two modes of operation: For the capture of communication parameters and for a 

general quality measurement in the field the 'automatic mode' is used. In this mode it is sufficient to 

connect the instrument via the adapter cable to the network under test and via the USB cable to a 

PC/notebook. After start of the control program and after a certain measurement time the data collected 

may be saved. In case errors or warnings are reported, they should be resolved using the advice given by 

the program in text output. For the 'automatic mode' no special knowledge of AS-Interface is required. 

 

The second mode, the 'expert mode', is intended for the detailed analysis of problems that may have 

been detected in the AS-Interface network. This mode requires special knowledge of AS-Interface and 

the applied principles of communication. It can be used by trained service personal in the field as well as 

by product development engineers in the laboratory. It allows an in-depth analysis of the communication 

on the network. 
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2 Preparation for the network diagnosis 

2.1 List of components 

The following components are shipped with the network analyser 'ASi View' in a plastic carrying case: 

● Network diagnosis tool 'ASi View',  

● Connection adapter (Art. No. 120010004),  

● ASiMA (Active measuring point M12 / Art. No. 120040000),  

● USB cable (2m),  

● the installation CD with the License file (ASi_View.ini) and documentation. 

 

2.2 The Network Diagnosis Tool 

The network diagnosis tool 'ASi View', in connection with a PC/notebook, is designed for the use in the field 

on machines and systems or in the development or application laboratory. Please ensure that the 'ASi View' 

(and the connected PC/notebook) remains dry and the connectors remain dust free, especially of conductive 

dust. Keep the 'ASi View' and PC/notebook well away from strong electromagnetic radiation sources. 

If used as network diagnosis tool the ASi View shall be connected to the AS-interface network under test 

only via the supplied connection adapter. The cable between the adapter and the instrument shall not be 

extended. 

 

2.3 The control program ASi View 

2.3.1 Minimum system requirements for the control program 

The minimum system requirements are: 

 CPU with 1000MHz clocking frequency,  

 mouse or other pointing device,  

 800 x 600 screen resolution,  

 256 colours (true color recommended),  

 CD-ROM drive (only for the program installation),  

 USB 2.0 interface,  

 Operating system Microsoft Vista, Windows7, Windows8.1, Windows10,  

 Microsoft® .NET Framework Version 4  

The program requires about 6MByte disc space. For every saved set of data a further approximately 

400kByte are required. 
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2.3.2 Installation of the control program 

If the Microsoft® .NET Framework is not installed on your Laptop/PC or if you have a version older than 4, it 

is necessary to update your installation either via internet from the Microsoft homepage or by installing the 

file available on the ASi View CD (dotNetFx40_Full.exe). 

Please install the driver for the 'ASi View', before you connect the instrument to the PC: 

 Insert the ASi View-CD into the CD-ROM drive. It should start automatically. If not, please start the 

program 'SetupFull_ASiView139'. 

 Follow the instructions on the screen for the installation of the software.  

 Please answer messages like 'Do you want to allow installation of programs of unknown sources?' with 

'Yes'.  

 Restart your PC. Now connect your instrument via the USB cable. Please ignore messages such as 'This  

device can support a higher data rate'.  

 The hardware-assistant is executed. Follow the instructions and select 'No', if the assistant wants to 

establish a connection to 'Windows Update'. If the warning is displayed that the Windows-Icon-Test has 

failed, please click on 'Continue the installation'.  

 If you want to connect the ASi View to further USB interfaces please repeat the previous step accordingly.  

 Depending on the configuration of your operating system, it may be required to log in as system 

administrator or as a user with administrative rights.  

Note: The program will only perform correctly if installed in a folder to which you have unrestricted read and 

write access. 

 

2.3.3 Deinstallation of the control program 

For a complete deinstalltion of the control program ASi View please follow the instructions listed below. It 

may be required to be logged on as administrator or user with administrative rights. 

● Click on the Windows Taskbar 'Start -> Settings -> Control Panel -> Add or Remove Programs'  

● If you do not want to delete your user files (and if these are saved in the program folder) click 'Delete'. If 

you do want to delete those files, click 'Change' and then 'Delete'. You will then be asked to confirm the 

deletion of the user files. 
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2.3.4 Elements of the network diagnosis tool ASi View 

The ASi View has 4 connectors and a LED (the numbers relate to figure 01): 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 01: The AS-Interface network diagnosis tool 'ASi View' 

 

(1) USB connection 

This is the interface for the PC connection, on which the control program runs. The connection cable is a 

standard USB cable. 

(2) CH A 

This is the connection for the test adapter. If you use this instrument as ASi View, then only the supplied 

adapter cable shall be used! This cable must not be extended. 

(3) CH B 

This connection is for the trigger signal input (for future versions of the ASi View) 

(4) SIGNAL OUT 

This connection is for the trigger signal output (for future versions of the ASi View) 

(5) red LED 

This LED signals functionality. While the ASi View control program runs it flashes at every read-in of a data 

set (ie. approximately every 250ms). 
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3 Execution of Measurements 

3.1 Automatic Mode: General Program Functions 

First, install the ASi measuring adapter (ASiMA) at a freely accessible point of the ASi flat ribbon cable. 

For simplified assembly and reliable contacting, it is advisable to remove the screwed-on measuring 

head, snap the base body with the specified profile around the cable and then screw the blade adapter 

back on again.    

                       

 Figure 2: Installation of ASi measuring adapter (ASiMA) 

 

To perform measurements, connect the ASi View to the measurement adapter using the M12 adapter 

cable and the USB cable to your laptop. 

ATTENTION! Do not short-circuit the adapter cable at the BNC connector! This would interrupt the data 

transfer on the AS-Interface network completely. 

Note: The adapter cable must not be extended, because then the capacitive load of the network rises 

due to the added capacity of the adapter cable. 
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To start the control program double click on the program icon on the desktop or double click on the file 

'ASi-View.exe' in the program folder that was created during the installation. 

The program starts with the start window shown in figure 3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 03: Start-up window of the control program ASi View   

(after connection to a AS-Interface network and about 1min testing time) 

 

 

Note: Depending on the chosen Windows® Appearance and selected color scheme the window can vary 

in its appearance. 

  



 

 

Execution of Measurements  

 

 

ASi View - User Manual  10 

 

The program searches for the connected hardware and tests the serial number of the device. If it cannot 

find a device, then the following message appears: 

 

The user can now choose whether he wants to select the 'Demo Mode' (click 'Yes'), connect the correct 

hardware and repeat the connection process (click 'No') or whether he wants to cancel the program (click 

'Cancel'). 

For the Demo Mode please refer to chapter 4 of this handbook. 

For protection against unauthorized usage the program tests the connected hardware and issues the 

following error message, if a wrong or not functioning hardware or hardware with the wrong identification 

is connected: 

 

 

 

For users that own more than one ASi View it is possible to load additional licence files. These licence 

files are delivered with every original product purchased. Up to 10 licence files may be assembled so that 

any of the 10 associated products may be used with the software. Please have the necessary licence file 

available and follow the further instructions on the screen.  

If the correct hardware has been recognised and connected, the measurements start automatically (see 

note in the status bar of the program at the bottom of the window). After a short acquisition time the 

window shows the result of the automatic network analysis. All results highlighted green are considered to 

be 'OK', all results highlighted yellow are intermediate and all results with red background are errors that 

should be corrected. 
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In order to set your language please select File -> Language Selection -> English. The selected language 

will be stored and used for future program starts. 

 

 

The following functions are available in the pull-down menu: 

File 

...Save Raw Data 

With this function a .txt file can be created, which contains the measurement data for archive storage. The 

data can be used in the demo mode of the ASi View or eg. Microsoft® Exel. The .txt file contains all 

relevant data in ASCII format: Date and time, the comments (for identification of the location of this 

measurement), the contents of the error counters and the individual measurement results of a set of 

measurements. 

...Load Raw Data 

With this function a .txt file (created with 'Save Raw Data') can be loaded and analysed in the demo-

mode. 

...Capture Screenprint 

With this function the currently displayed screen can be captured and saved on disk in .JPG format. 

...Output Data 

With this function the information of the current window can be saved either in a local file or in printed on 

a printer for further processing or for documentation purposes. 

...Language Selection 

With this function the program language can be selected between English, French and German. 

...Exit Program 

Closes all open data, saves some settings and closes the program. 
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Settings 

Note: These settings, apart from 'mode', are accessible in expert mode only. 

...Zoom Y-Axis 

With this function the Y-axis can be scaled (only 'Oscilloscope' in expert mode). Usually the default 

setting of ±4V (maximum swing) is sufficient. At some locations the voltages are so small, that ±2V gives 

a better image. 

...Zoom X-Axis 

With this function the display of the AS-Interface cycle can be magnified in 4 steps in 'Oscilloscope' in 

expert mode. The standard setting is 1ms. 

...Trigger options 

With this function different trigger options can be selected (only for 'Oscilloscope' and 'Signal Quality - 

Details' in expert mode): Either all messages that are exchanged with a certain slave are displayed, or 

only data messages, only parameter messages, only different organization messages, or only messages 

containing errors. The default at start-up is 'all messages'. 

...Display options 

With this function different settings for the display can be selected (only for 'Oscilloscope' and 'Signal 

Quality - Details' in expert mode): the 'slow fade', ie. the display of not only one trace, but also the last 2, 

5, 10, 20, 50, 100 or all traces, and additional information. If this option is chosen, in the case of 

'Oscilloscope' the displayed message is directly decoded with start and stop, control and parity bits. In the 

case of 'Signal Quality - Details' the curve trace after the end of the message is also displayed (in green 

colour) in addition to the curve trace of the message in order to be able to monitor the pause after the end 

of the message. 

...Filter 

With this function a software filter (Butterworth filter of 3rd degree) with a corner frequency of 500kHz can 

be activated. If high frequency noise is in the network this filter can improve the detectability of AS-

Interface messages significantly. In automatic mode this filter is always activated. 

...Voltage calibration 

With this function the voltage displayed in the "Signal quality -- Details" and the "Oscilloscope" tab can be 

corrected by ±30%. This may be necessary if adapters with analogue filters are connected. The 

correction factor is saved in the INI file. 

...Program mode 

Here the mode 'automatic mode' or 'expert mode' is selected. The default setting at start-up is 'automatic 

mode'. 
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Info 

...Help 

This window gives a short online help in the language selected. 

...About ASi View 

This window shows important program information. The version info as well as information about the 

operating system are required for feedback for technical support. 

The other elements of the start window are: 

Location 

In this window the location of the measurement can be entered. This will be copied to the output files. As 

many of the recorded data is directly dependent on the measurement location, this information is of great 

importance for a later analysis. 

Event history 

Beginning with the start of the network monitoring all events that are registered by the ASi View are 

documented here with exact date and time. 

Note: Entries in this window are made in 'Automatic Mode' only. 

Current problems/faults 

In this window all events that lead to a change in the network status are listed. If the network status is 

'OK' then this window is empty. If the network status is 'Warning' or 'Fault' then all faults or warnings that 

led to this status and caused the ASi View to diagnose this status are listed. 

Button 'Reset' 

By clicking this button all internal forms and data entries are reset, so that the measurement starts again 

like after a program start. 

Button 'Print Protocol' 

By clicking this button all the information’s that have been collected over the measurement period are 

saved in a file or printed on the selected printer. Please refer to the appendix of this documentation for a 

sample protocol. 

Date (Status bar) 

Here the date and exact time of the measurement is displayed (taken from the system clock of the 

PC/notebook). 
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Status information (Status bar) 

Here it is displayed whether a AS-Interface signal is received correctly. If this is not the case, the status 

information displays 'NO AS-I Signal!'. If data is read-in cyclically from the AS-Interface network, then this 

field displays 'Reading AS-i Signal...', where the points are moving. The user thus can see that the 

program is active. 

Master type detected (Status bar) 

Here the type of the master controlling the network is shown. This is either a "M-0, M-1, M-2 Master" 

which can communicate with Standard- and A-Slaves only and which does not read the extended ID-

codes and the status information. The other possible master type is the "M-3, M-4 Master" which also 

communicates with B-Slaves and which reads the status information cyclically. 

Data Traffic Monitored (Status bar) 

With this graphic display the percentage of the total data traffic monitored and analysed is shown. Every 

green unit represents 10% of the time. The maximum possible is 40%, the percentage achieved in reality 

depends on processor performance, the capabilities of the graphic co-processor and the use of resources 

of other programs that may be running. This display is visible only in expert mode. 

 

 

Additionally the standard elements for the 'Windows' windows are available, eg. the buttons in the top 

right hand corner. Furthermore, a handle in the lower right hand corner is available, with which the 

window can be pulled to the desired size. The minimum size is 600x800 pixel. The maximum size is 

limited to 1000x1400 pixel, but may also depend on the monitor size and its resolution. 
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3.2 Expert Mode 

In Expert mode 8 register cards appear, which summarize and display one function of the ASi View each. 

Note: Please be aware that in some display modes not all information can be displayed if the window size is 

not large enough. 

In the status bar of the program window the following trigger information can appear in the expert mode: 

Trigger information (status bar) 

The trigger status is displayed here. There are two cases: 'STOP after command HALT', when the user 

clicked the trigger function. And 'Waiting for trigger (xx)', when more than 1 second passes until the next 

curve trace is written (which can be the case when the trigger is set to a slave that is not activated). The 

number in brackets shows the remaining number of curve traces until the display update is stopped. 

3.2.1 Expert Mode: Display mode 'Signal Quality - Overview' 

 

In this display mode an overview of the current signal quality of all active transmitters on the network is 

displayed. A green bar (in the range 100 ... 150%) indicates, that the signal quality of the transmitter in terms 

of its amplitude and timing is regarded ok. A yellow bar (in the range 80 ... 100%) shows that the signal 

quality is still sufficient, but has no reserve. Finally, a red bar indicates that the signal quality with <80% is 

outside of the system specification and actions for improvement are required. 

For the definition of signal quality please refer to chapter 6 of this handbook. 
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The signal quality is dependent on two parameters: the amplitude of the transmitted signal and the timing, ie. 

the time difference of the individual pulses of the signal to each other. The overall signal quality shows the 

minimum of those two parameters. You can make each one visible by clicking the associated selection 

buttons ('radio buttons'). 

When a standard slave is configured on an address (address 2 in the figure above), then in the place of the 

B-slave a marker is shown which indicates that no other slave can be placed here. 

3.2.2 Expert Mode: Display Mode 'Signal Quality - Details' 

With this display mode the active transmitters in the network can be made visible with their signals in a 

standardised way. For this the 'eye diagram' is used, which allows a judgement on the signal quality 

independent of the data content of the message. The grey shaded areas help with the orientation: The 

curves should not cross through these areas (with the exception of the green curve). 

With the eye diagram two curve traces are color highlighted: one red and (if 'additional information' is 

selected) a green curve trace. 

The red curve represents the first negative pulse of the displayed message. This is used for triggering the 

scanning and decoding of the signal and, at the same time, for the calibration of the trigger level. 

The green curve, which represents the 6 µs gap after the end of the message, is not usually displayed. It is 

only shown when the option 'Settings ->  Display Options -> Additional Information' is activated. 

The displayed transmitter can be selected by clicking on one of the identified transmitters in the network, 

which are displayed in the combo box 'Participants'. 
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When the display option 'Settings -> Display Options -> Fading' is selected with values > 1, several curve 

traces are superimposed, so that the signal jitter and/or individual deviations from the normal trace can be 

made visible. 

Note: With non-activated slaves it can under certain circumstances take a while until the curve traces are 

displayed, because the master only calls these slave every once in a while. 

When the trigger option 'Settings -> Trigger Options' is selected, then signals can be filtered out that belong 

to certain options. For example the trigger can be set on to messages that contain an error. Messages are 

also considered to contain an error when they are repeated by the master, even if the ASi View at the point 

of measurement cannot identify an error. 

For the definition of the eye diagram and for examples of eye diagrams of good and incorrect transmisions 

see chapter 6 of this handbook. 

The signal amplitude of the first pulse of the message is displayed under the eye diagram. The content of the 

message is displayed for slave attributed messages. In case there is an error the detected type of error is 

displayed in text (eg. 'Parity Bit Error'). Also repeated messages are considered as errors. In this case the 

message is displayed that caused the repetition. 

Next to the eye diagram the two parameters 'signal quality (timing)' (left bar) and 'signal quality (amplitude)' 

(right bar) are shown as bar graphs, under which the number is shown that represent the minimum of both 

measurement results. 

The button 'Halt' stops the recording of further curve traces (either immediately or, when the function 'Fading' 

is selected, after the selected number of curves have been recorded), in order to have time to analyse the 

result or to archive it for later analysis. By a second click on this button the normal recording is continued. 
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3.2.3 Expert Mode: Display Mode 'Error Statistic - Overview' 

In this display mode the communication error rate is displayed in an overview for every active slave identified 

in the network. When the communication between master and slave has a <1% error rate, the 

communication is considered ok (green background). Only data transmission messages are taken into 

account, all other messages that are exchanged with the slave are ignored. A warning is issued when the 

error rate is between 1% ... 5% (yellow background). If the error rate is >5% an error is shown (red 

background). Slaves shown with a grey background are on the network, but do not take part in the cyclic 

data communication. Apart from the error rate the status is displayed for all slaves. When the status 

information is not 0 (eg. due to a periphery fault), then the field in the corresponding column is red. 

 

The number in the respective position shows the number of telegram repetitions that were detected in the 

communication between the master and the slave. Here only telegram repetitions are counted, for all other 

errors detected please refer to the display mode 'Error Statistic – Detail'. 

The button 'Reset' resets the corresponding error counters, so that a new set of measurements can be 

started, eg after a correction on the network. 
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3.2.4 Expert Mode: Display Mode 'Error Statistic - Details' 

This display mode is the same as the 'Error Statistic - Overview' with the additional display of the exact 

number of analysed messages and the exact number of master errors and slave errors. Out of these 

numbers the error rate can be determined. 

Errors are considered master errors, when 

 the master signal contains a qualitative error (e.g. low signal amplitude) or the master call a content 

related error (e.g. parity bit error), 

 the master repeats the message, although the slave answered correctly. 

Note: If numerous master errors are recorded although only few telegram repetitions are registered, please 

select a different point of measurement. 

 

Errors are considered slave errors, when 

 the slave does not send a reply to a correct master call,  

 the slave reply contains a qualtiative error (e.g. a timing error in the telegram) or a content related 

error (e.g. stop bit error). 

Note: Erroneous messages that are so badly corrupted that the ASi View cannot decode them, together with 

the possible slave reply, are not counted. 
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Normally only data exchange telegrams are evaluated and errors counted that are detected during data 

exchange. With the help of the radio buttons in the bottom left of the window the display can be changed 

from displaying data exchange errors to errors that occurred during the exchange of all other telegrams. This 

includes parameter exchange telegrams, status telegrams or telegrams that are exchanged when the master 

identifies a new slave. If the error rate during data exchange is low and at the same time the error rate during 

exchange of other telegrams is high then a duplicate addressing situation is likely. 

The button 'Reset' resets the corresponding error counters, so that a new set of measurements can be 

started, eg. after a correction on the network. 

The button 'Halt' freezes the display, until the button is clicked again. The counters continue to count in the 

background during this time. 

 

3.2.5 Expert Mode: Display Mode 'Oscilloscope' 

In this display mode either the entire AS-Interface cycle or a master call and (if present) the corresponding 

slave reply are displayed as curve trace as it was measured on the cable at the location of the measurement. 

The trace to be displayed is selected via the combo box 'Participants' in which all trans-mitters in the network 

are listed. 

 

 

All identified slaves in the network are marked with a ">". 

The curve trace displayed is the one selected from the 'participants' of the identified transmitters in the 

network from the combo box. This can be either all slave addresses possible in the system or all active 

slaves in the current network depending on the settings of the trigger option ('Settings -> Trigger Options'). It 

is also possible to trigger on erroneous messages only. A message is also considered erroneous when it is 

repeated by the master, even though the ASi View may not have been able to detect an error. In this case 

the message that caused the repetition is displayed. 

The following additional informations are displayed under the oscilloscope: the message length, the master 

pause, the slave pause (in µs) as well as, if possible, the type of message, the identified error and the 

information content. 

Several curve traces are superimposed, so that the signal jitter and/or individual deviations can be made 

visible, when 'Settings -> Display Options -> Fading' has been selected with a value >1. 
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Note: With non- activated slaves it can under certain circumstances take a while until the curve traces are 

displayed, because the master only calls the slave every once in a while. 

The corresponding information is displayed directly under the curve traces, when 'Settings 

-> Display Options -> Additional Information' -> has been activated. 

The entire cycle is displayed as a curve trace, when 'Cycle' is selected instead of a slave address in the 

combo box 'participant'. Also the currently measured cycle time and the stated cycle time is calculated and 

displayed. The stated cycle time corresponds to the 'stated cycle time' which is defined in the specification 

[1]. 

 

The AS-Interface cycle can be displayed in 4 different time scales which are selected via 'Settings  Time 

Scale (X)'. With the radio buttons provided in the bottom left of the window it is also possible to select to view 

the A- cycle only, the B-cycle only or both cycles. This can be useful if the lengths of the A- and the B-cycles 

differ. 

The button 'Halt' stops the recording of further curve traces (either immediately or, when the function 'Fading' 

is selected, after the selected number of curves have been recorded), in order to have time to analyse the 

result or to archive it for later analysis. By a second click of this button the normal recording is continued. 

The selection 'Settings  Trigger Options  faulty telegrams/cycles only' allows to display only those cycles 

in which errors were detected. For a better overview the erroneus transmissions are displayed in red. 
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Information about the slaves contacted in the cycle is displayed directly under the curve traces, when 

'Settings  Display Options  Additional Information' is activated. For certain settings of the window size, the 

time scale and the length of the cycle it may not be possible to display the complete information due to space 

restrictions. 

 

 

3.2.6 Expert Mode: Display Mode 'Network Configuration' 

In this display mode all known information about slaves detected on the network is collected. This contains 

slaves that may have only been temporarily connected. These are in particular the ID-code and the status 

information, that are cyclically called for by the master of all slave addresses. 

If the slave is not active (i.e. does not respond to data requests of the master) the background of the 

respective slave is coloured gray. This is also the case if the slave was temporarily active and is inactive at 

the time of observation. If the slave is active (i.e. does respond to data requests of the master) the profile, 

however, is unknown, then the corresponding background colour is yellow. If this is the case the ASi View 

cannot allocate the slave data to a standard or an A/B-slave. The background is green for active slaves, if at 

least the ID0-code is known. 

When the ASi View recognises that the collected information can cause a conflict (for example, that a 

standard slave and a B-Slave are on the same address, which is the case in the figure below on address 10), 

then the corresponding fields have a red background. 
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Note: It is possible, that slaves are on the network, that never send slave replies that are decodable by the 

ASi View. Therefore it is possible, that there are more slaves in the system than are displayed. 

The button 'Reset' resets all corresponding data fields, so that the recognition of slaves starts again. 

 

3.2.7 Expert Mode: Display Mode 'Communication Protocol' 

In this display mode the communication protcol between master and all slaves is shown. In the columns of 

the protocol the following information is presented: 

1. Nr.: the figure left of the point shows the number of the cycle (beginning with 1), the figure on the right 

shows the number of the telegram in this cycle. 

2. slave address  

3. Master request: Command: This is the master command.  

4. Master request: CB, I4, ... I0: These are the data bits (besides the address, the start bit, parity bit and stop 

bit) that the master has sent to the slave. Depending on the type of master request they are to be interpreted 

accordingly. The data bits are shown as sent in the master request and not as the host has sent them. Under 

the heading “Hex” the data bits are displayed in hexadecimal notation. 
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5. Evaluation: In this column an evaluation of the master request is given. This may include errors in the 

master request (alternating error, data bit error, parity error etc.) or warnings (signal quality, telegram 

repetition).  

6. Master pause: Here the time between the end of the master request and the beginning of the slave 

response is shown.  

7. Slave response: I3, ... I0: These are the data bits (framed by start bit, parity bit and end bit) that are sent 

back by the slave in its response. Under the heading “Hex” the data bits are displayed in hexadecimal 

notation.  

8. Evaluation: In this column an evaluation of the slave response is given. This may include errors in the 

slave response (alternating error, data bit error, parity error etc.) or warnings (signal quality).  

9. Slave pause: the time shown represents the pause between the end of the slave answer and the 

beginning of the next telegram. It contains the slave pause plus – if applicable – the additional send pause of 

the master. 

10. Telegram length: This is the sum of the times of the master request, the master pause, the slave answer 

and the slave pause. 
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If there is no slave response at all this is stated alternatively in plain text. 

The button 'Hold' temporarily stops the recording of further protocols for a detailed analysis. By a second 

click on this button the normal recording is continued. 

If "Settings -> Display options -> Additional information" is activated the measured cycle time, i.e. the sum of 

all telegram lengths, is displayed at the end of each cycle. 

If a particular slave instead of "master/cycle" is selected in the combobox "Participants", then the data 

exchange with this slave is displayed exclusively. 

By selecting one of the possible trigger options ("Settings  Trigger options") telegrams may be filtered in 

various ways. If, for example, the option "Data telegrams only" is selected all other telegrams are suppressed 

improving the clarity of the display. If the option "faulty telegrams only” is selected then only cycles that 

include erronous telegrams would appear in the display. 

With the menu option “File -> Output data -> File” the collected data can be saved in CSV format for further 

processing. Data in CSV format may be used as input for EXEL®, so that further analysis of the data can be 

performed. With the menu option “File -> Output data -> Printer” the complete protocol may alternatively be 

printed. 

 

3.2.8 Expert Mode: Display Mode 'CTTx Protocol' 

In this display mode the data exchange between Master and a Slave is shown, if they communicate via a 

CTT protocol. In this case the information exchange is accomplished by exchanging several telegrams and 

putting the information together according to the rules of the particular protocol used. The ASi View can 

reconstruct this information when the following inputs are given: 

–   the slave address in the upper select box and  

–   the slave profile in the lower select box.  

Note: If the slave selected does not have the chosen slave profile it is possible that the data exchange is 

interpreted and displayed in a wrong way. The ASi View cannot check in all cases that the protocol selected 

is actually used. 

The Safety protocol is considered to be a CTT protocol, too. The safety code of the slave can be displayed in 

this window if selected. 
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The following CTT protocols can be displayed: 

• S-0.B.*.* Safety Slave without outputs 

• S-6.0.*.* CTT5 Slaves (8, 12, 16Bit input and output) 

• S-7.1 (Inputs) CTT1  Slaves  with  1...4  analogue  or  transparent  inputs 

  (according to Spec. 2.1, not for new products) 

• S-7.1 (Outputs) CTT1 Slaves with 1...4 analogue or transparent outputs 

  (according to Spec. 2.1, not for new products) 

• S-7.3.*.* (Inputs) CTT1  Slaves  with  1...4  analogue  or  transparent  inputs 

  (according to current specification) 

• S-7.3.*.* (Outputs) CTT1  Slaves  with  1...4  analogue  or  transparent  outputs 

  (according to current specification) 

• S-7.5.*.5 CTT2 Combi slaves with 2 inputs and 2 outputs plus a serial 

  input/output channel 

• S.7.A.*.5 CTT2 Combi slaves with 2 inputs and 1 output plus a serial 

  input/output channel 

• S-7.A.7.7 CTT3 Slaves with 4 inputs and 4 outputs 

• S-7.A.7.A CTT3 Slaves with 8 inputs and 8 outputs 

• S-7.A.*.8 CTT4 Slaves with 1 analogue or transparent input 

• S-7.A.*.9 CTT4 Slaves with 2 analogue or transparent inputs 

• S-7.B.*.* Safety Slave with (unsafe) outputs 

• S-B.A.*.5 CTT2 Slave with a serial input/output channel 

Note: A * in the profile means any character in the range 0...F. 
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Note: In CTT2 communication the number of telegrams that contain relevant information is relatively high. 

It is, therefore, possible that the information fits into the buffer only when no other (or only few) slaves are 

present in the network. 

When some of the protocols are selected the number of AS-Interface cycles that are needed to update 

the data and the update time are shown additionally. This information may be useful in time critical 

applications. 
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4 Use of the 'Demo Mode' 

Data sets of the ASi View can be saved for later evaluation via the function 'File -> Save raw data'. 

Analysis of saved data sets is performed in DEMO mode. 

The DEMO mode can be entered by starting the control program without an ASi View connected the the 

PC and by answering the inquiry 

 

with 'Yes'. 

In DEMO mode the program automatically loads the file 'Demo-Mode.txt' which is provided when 

installing the program. If this file is not found or damaged then a selection window opens in which a data 

set can be identified for loading. Alternatively it is possible to load data sets with the function 'File  Load 

raw data'. 

The data sets contain 30000 data points and thus cover a measuring time of approxi-mately 12ms. 

Additionally data on signal quality, number of errors and configuration of the network is saved in the data 

sets. The data sets are formatted as plain text and can also be read by other application programs (e.g. 

EXEL®). 

The file name of the data set loaded is displayed in the status bar with yellow background. Further the 

point of measurement and date and time of the measurement are displayed at the respective places on 

the window. 

In Automatic Mode of the program the user will get the usual overview of the network and (if the network 

status is 'Warning' or 'Error') the informations that explain the reasons for the deviation from the OK state. 

In DEMO mode the event window will not be used. 

In Expert Mode all informations that can be retrieved from the loaded raw data are displayed: 

–   the measured signal qualities of all transmitters,  

–   the eye diagrams of all transmitters,  

–   the error statistics that were gathered up to the point in time when the data set was saved,  

–   oscillographs of the cycles or the communication between master and slaves,  
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–   the network configuration, 

–   the communication protocol and  

–   the CTTx information, if it is completely contained in the raw data set.  

Operation of the different program functions in DEMO mode is – with one exception – identical to the 

normal mode. You can, for example, make use of the function 'fading' in order to write several traces on 

top of each other to identify signal jitter. 

If you use the tab 'Oscillographs” in DEMO mode you will find some additional elements of operation. In 

DEMO mode these appear in the top right hand side of the window and allow to navigate within the 

recorded data set. The digits displayed in the center between the buttons (in the figure '02.03') identify the 

cycle number and the telegram 

 

number within the cycle and correspond to the numbering in the communication protocol. With this 

navigation all telegrams recorded in the communication protocol can be made visible as traces. 
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5 Technical Data 

DC power supply 

via USB-connection from the PC/notebook 

max. current: 420mA 

 

Data Measurement 

Voltage: max. 40 VPP 

Frequency: AS-Interface Frequency Spectrum 

Scanning rate: 2.5MHz 

Recording time for one block of data: 100ms 

 

Note 1: The measurement is only carried out galvanically seperated when the supplied measurement 

adapter is used. Otherwise the AS-Interface network may be influenced by the measurement. 

 

Note 2: Approximately every 250ms a data block is recorded. Therefore approximately 40% of the time is 

covered by measurements. 

 

Measurement Results 

relative measurement error: <±3% under calibrated condition 

 

Environment 

Protection rating: IP20 

Temperature Range: 0 ... 45°C 

Humidity: max. 80%, non condensing 

 

Communication Interface 

USB 2.0 
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6 Signal Quality in AS-Interface Networks 

The ASi View opens a new dimension of quality measurement of AS-Interface networks. In the following 

the definition of signal quality is explained, the eye diagram described and it is shown with a few 

examples how to interpret certain features. 

An AS-Interface signal of sufficient quality, which should be decodable error free by every receiver in the 

network, fulfills the following conditions: 

 

a signal amplitude of more than 3VPP [1],  

 

pulses have an amplitude difference of <30% [1] and  

a single pulse has a timing error relative to the first negative pulse of less than +1µs/-0,5µs [1].  

 

Especially the third condition is very hard to check by normal means, because the timing cannot be made 

visible with the required accuracy. 

 

Here comes the 'eye diagram' into play, which the ASi View offers as diagnosis tool. The eye diagram is 

created in the following way: 

 

1. The start pulse of a message is found and its amplitude measured.  

 

2. Time is set to 3µs at 50% of the signal amplitude of the start pulse.  

 

3. The message is split into 6µs long time fragments, which are all superimposed.  

 

The result is shown in the figure below. Due to the 'APM' modulation the result is a 'double eye'. Only the 

right eye contains information and therefore has to be 'open', the left eye may also be 'closed'. 

 

In general one can see now that the eye aperture is a direct measure of the signal quality. Because of the 

APM modulation errors in the left eye also have a negative effect on the signal quality. With this eye 

diagram it is now possible for the first time to check the AS-Interface signal qualitatively at the location of 

the measurement. 

In a second step the AS- iExpert now assesses the eye diagram quantitatively and filters out two figures 

of merit of the signal quality from the eye diagram. The first figure of merit rates the absolute and relative 

pulse amplitude of the message pulses and the second the timing allocation of the different pulses 

relative to each other. 
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pulse amplitude: The pulse amplitude rates the vertical eye aperture of both eyes. A message which has 

at least 4.5 V PP signal amplitude and the amplitudes of all pulses of the same size is rated 150%. 0% is 

given to a 'message', which has an amplitude of the first pulse = 0V. The difference between the 

maximum amplitude (peak value) and the minimum amplitude leads to a degradation of the pulse 

amplitude result. 

 

 

 

 

Time Frame: The time frame rates the horizontal eye aperture of both eyes. 150% is given to messages 

that are optimally positioned within the time frame. These are curves that pass the trigger level at exactly 

the intended time. 0% is given to those 'messages' which have no pulses above the trigger level other 

than the first pulse. The scale in between is linear. In real networks values are usually <140%. 

 

Which typical network- or participant-error can now be recognised with this new tool? For illustration 

purposes a few selected error images are presented in the following section. Further you may consult the 

computer based training program [2] that is supplied on the CD and that describes some typical network 

problems and how they can be identified and corrected with the ASi View. 
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1. Slave message with 'No-Information-Error' 

 

The upper figure shows a master call and a slave reply as curve trace on the oscilloscope, in which the 

'No- Information-Error' is included (ie. a time shift of an information pulse). On first sight the message 

seems to contain no error. The lower figure shows the same slave reply as eye diagram. Here it is 

immediately visible, that the curve trace runs through the middle of the right eye, which is not allowed 

according to the coding rules. 
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2. Slave with offset oscillator frequency 

 

The oscillator frequency of the here shown (experimental) slave can be varied. The upper eye diagram 

shows the case, where the oscillator frequency is correct. The pulses arrive at the correct time relative to 

the first pulse shown in red. The bottom eye diagram shows the case, where the oscillator frequency is a 

little too low. For this reason the pulses arrive a little after the red first pulse. Slaves with offset oscillator 

frequencies can show increased error rates in networks that already have pulse delays due to 

propagation delay or capacitive loading. 
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3. Capacitive loading on the network too high 

 

When the capacitive loading on the network increases the short pulses become lower in amplitude than 

the long pulses. On top of that conspicuous overshoots occur at the end of the messages. On the 

oscilloscope (seemingly small) delayed pulses are shown. In the eye diagram the communication problem 

is immediately visible: the short pulses fall distinctly too late below the trigger threshold, run through the 

shaded areas and cause 'alternating pulse errors' (the red arrows point to the critical parts of the curves). 
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4. Network too long 

 

When the network is longer than the maximally allowed length of 100m, the super-imposition of reflected 

waves from the long end leads to signal distortion. In the upper figure this can be seen in the oscilloscope 

at the double peaks of the long pulses. The lower figure shows the corresponding eye diagram. It can be 

seen that the maximum timing tolerance at the trigger level is greater than +1µs/-0,5µs and hence above 

the limit given by the specification. 
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8 Trouble Shooting, Feedback and Support  

If something does not work as anticipated during installation or use of the ASi View please refer to the 

following list and check if your problem is described. 

Problem Cause     Possible action   

1  If the start image persists for • Use shorter USB cabel.  
  a  long  time  (>20s)  the • Remove other devices from other 
 power supply  of the  USB ports.   

  hardware via the USB cable      

 is not sufficient.         
     

2  The program cannot find the • Connect hardware to the correct 
 expected  hardware. It may  USB port.   

  not be connected at all or • Reinstall  PicoScope driver 
  connected to the wrong USB  software    

  port. See also under (1).  • Select Demo Mode  

3  Hardware and Ini File do not • Press "No" button. Connect 
 correspond.     correct hardware. Restart 
       program.   

      • Press "Yes" button. Load correct 
       Ini file from installation CD. 

4  You have not sufficient read • Repeat program installation to a 
  and  write  access  to  the  different folder for which you have 
  folder  in  which  you  have  unrestricted read   and write 
 installed the  ASi View  access.    

 software.          

5  The Ini file is not installed in • Delete  the possibly existing  but 
  the  correct  folder  or  is  corrupt file and reinstall it from 
 damaged.      the installation CD to the folder of 
       the ASi Viewxxx.exe.  
     

6  The hardware is connected • For correct operation of the AS- 
 to a USB 1 port.     iExpert  a  USB  2.0  port  is 
       mandatory.   Connect   the   AS- 
       iExpert  to  a  USB  2.0  port  and 

       restart the program.  
 

If you have feedback or need support, please use the following email address: info@indu-sol.com 

 

Please include your serial number of your ASi View (on the type label on the back of your device), the 

Operating System and the version number of your operating system and your program. This information can 

be found under "Info -> about ASi View". 
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